Introduction

Every time [ turn around, [ see more great tools for creating Web pages
and Web sites. At the same time, World Wide Web art and technology
advance at a rate that’s astounding. A few years ago, people were impressed
by animated images bouncing up and down on their page or by happily
blinking text. Now, Web pages and sites are castles of art and design with
liquid pages that respond to your touch and remember your name.

Welcome to GoLive 6 For Dummies! Anyone from a novice to a professional
designer can use this book to create great-looking, sophisticated sites. Want
to learn how to use GoLive 6 without a degree in computer science? This is
the book for you. You get what you need, when and where you need and want
it. In no time, you’ll be creating sites that you never thought you could create.
You may even start your own business on the Web.

If you’'ve ever wondered how Web designers accomplish these major feats,
let me give you a tip: Do not look at the source code. Both Netscape Navigator
and Internet Explorer have source code views built into their browsers, and
when you look at a site’s code, it can be scary — it’s a mass of JavaScript,
Cascading Style Sheet tags, calls to files named .swf, maybe some applets,
plus loads of mind-boggling HTML.

I'll let you in on a secret. The Web designer didn’t put in all that code. She
may have tweaked it a little, but you can bet your neighbor’s dog that she
used a page-development tool. It wasn’t some little freeware tool downloaded
from the Web — it was a full-tilt-boogie, site-crunching, code-making, image-
enhancing, big, bad site-development tool.

Here’s the best part. If that tool was Adobe GoLive 6, the designer didn’t
have to spend lots of time on the great-looking site. She may have had to
patiently consider a navigation system, with lots of help from the GoLive 6
design-planning tools, and she had to develop and gather images and
content. However, after those chores were done, all the pieces were
organized, updated, optimized, and synchronized by GoLive 6. Those
really cool rollovers, the integrated color scheme, and the nifty floating
boxes were all coded, loaded, and floated by GoLive 6.

At this point, the only question should be “How can I learn to use GoLive 6?”
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About This Book

This book is a user’s book. By that, I mean that you don’t curl up in bed with
it, like you would with a copy of Great Expectations. You use this book with
Adobe GoLive 6 loaded on your computer and ready to go. You can use the
book to find out about GoLive 6 from scratch, or you can use it as a reference
when you want to look stuff up on the fly. Keep it handy, and flag those
sections you use often.

Each chapter deals with a logical chunk of GoLive 6. If you want, you can

read the book from beginning to end, but (unlike your high school English
teacher) I'm not telling you that you have to. If you want to find out about a
certain aspect of GoLive 6, you can flip to a chapter to immediately see a list of
what the chapter covers. You don’t have to read the previous chapters, either.
If you want to learn how GoLive 6 deals with frames, just go to the appropriate
chapter and follow the guidelines. Like I said, this is a user’s book — so use it.

You can find a wide range of material about GoLive 6 within the pages of this
book. It is organized so that the basics are near the front, including a chapter
on design and HTML. You will find how to create and control frames, windows,
and floating boxes and use them together on a Web page. You find out

about using the special GoLive windows, dialog boxes, toolbars, and palettes
to outline, create, and maintain an orderly Web site and navigation system.
Matching colors between the Web and a graphic on the page is explained
along with using the GoLive 6 grid to make creating designs a simple task.
Even a built-in FTP (File Transfer Protocol) application makes it easy to

load your pages to a Web host server while maintaining all the links you
established on your own computer.

A brand-new feature introduced with GoLive 6 is the workgroup server. The
server software that comes with GoLive allows you to set up your computer
to act as a server while at the same time being used to develop a Web site.
You can work with developers and designers in the same building or with
other team members around the world. (I personally tested it with a site
connecting Argentina and Connecticut.) Site-development team members can
work on the site together by checking elements in and out, and then others
can add to, change, or remove page features. The server is worth the price of
the GoLive 6 software alone, but you get it included at no additional cost.

How to Use This Book

You may have noticed the detailed table of contents and index in this book.
They're tools to be used. Typically, when you want to know something about
GoLive 6, you don’t expect to pick up the book and begin on page 1 for a
topic on page 253. You look up the chapter or a key word in the index and
then go directly to the part you want.
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You can take or leave the tips, warnings, and technical explanations, but
you’ll probably find them useful. Here’s a tip you can take or leave: Go down
to your local office-supply store and get a set of those sticky tabs you can put
in your book. Use a different color for each topic that interests you. That way,
you can quickly look up information you've tagged. (See? You can take it or
leave it, but there it is.)

The book has detailed instructions on how to get something done with

GoLive 6. At times, the instructions may appear to use material from earlier
chapters or even earlier sections of the book that you know well. However,
that’s the whole point: You don’t have to carefully read Chapter 1 before you
can use the information in Chapter 7. Usually, I give you more than one way to
perform a function with GoLive. For example, to put a graphic image on a page,
[ tell you to drag it from the Site window, use the Point-and-Shoot button to
place it, or use the Browse window. Likewise, I give you both the menu path to
a tool and the keyboard shortcut, just in case you prefer using the keyboard.

The book contains some HTML and JavaScript code (but not a great deal of
it) that you can enter yourself. GoLive generates the great bulk of the code on
a GoLive 6 page. What little code there is looks like this:

function goFigure() {

var taxrate=parsefFloat(document.calculate.tax.value);
var ship=parseFloat(document.calculate.shipping.value);
var stuff=parseFloat(document.calculate.item.value);
var combine=(stuff + ship +(taxrate * stuff));
document.calculate.total.value=combine;

}

Although I don’t present much code, what there is clearly stands out using a
monospace font, as shown in the preceding code. As in the rest of this book,
you use just what you need. (You don’t need to program a single line of code
to use GolLive 6, but if you like to add your own code, doing so is easy.)
Whenever [ want you to type something, [ present it in a bold typeface.

What You Don’t Need to Read

If you don’t have access to and never plan on using WebDAV with GoLive,
don’t feel obligated to read the material on WebDAV. On the other hand, if you
bought this book because it does cover using GoLive with WebDAV, just read
the material on WebDAV and nothing else. There’s probably much more
information here than you want to know about, and that’s fine. A book’s value
is measured by what you do get from it; not by what you didn’t want to waste
time reading. Read what you need — from cover to cover or just those parts
when and if they help you get done what you need done. In addition, if the
paragraphs marked by those little Technical Stuff icons start to give you a
headache, skip those, too.
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Foolish Assumptions

I assume that you know how to install GoLive 6 on your computer and how to
use either the Windows or Macintosh operating systems to launch a program.
[ assume that you are not a computer programmer and that you do know
what the World Wide Web is and have used an Internet browser, such as
Internet Explorer or Netscape Navigator. (This statement further assumes
that you know what a Web page is.) You don’t have to know how to create
Web pages. [ just assume that you know what a Web page is when you see
one. Otherwise, this book assumes that you want to find out how to use
GoLive — and little more.

How This Book Is Organized

This book is arranged into five parts. Each part organizes related chapters
based on either the level of complexity or their common elements. The
chapters’ order within each part is not as important as the order within

each chapter. Some features require foundational knowledge. Chapter 1 is
important if you're new to GoLive 6 because it introduces the way you use
GoLive 6 as a tool. You'll see that the user interface (or U], for the totally
cool) is unique compared to other applications you may have used. However,
each chapter is self-contained, and you can use the chapters and sections to
get just what you need when you need it.

Part I: Ready, Set, GoLive 6!

These first chapters give you a running start with GoLive 6 by showing you
how to use the key tools and letting you jump right in and use them. This
part assumes very little and even guides you through some design tips.

It also pops the hood on HTML and lets you know what’s going on behind
the scenes just in case you want to tweak some code.

Part II: Looking Good:
Designs That Delight

This part brings together key elements of Web pages and GoLive 6. You find
out how to enhance your Web pages and site by using key Web page elements,
including forms, frames, and style sheets. In this part of the book, you find the
next level of Web site authoring beyond the basics of both GoLive 6 and
creating Web pages and sites.
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Part I11: A Site for Sore Eyes: Caring for,
Feeding, and Organizing Web Sites

Part Il shows you how to work both on a site level of development, design,
and maintenance and how to use common components throughout a Web
site. By using components, stationeries, and templates, you can create a
design once and use it lots. You can not only discover ways to organize your
site, but also find and incorporate some features in FTP and WebDAV that you
may not have realized existed. (A server is the computer where you put your
Web pages so that they can be accessed on the World Wide Web.)

Part IV: Swinging Pages: Tapping the
Power within GoLive 6

Here’s where the fun is. In this section, you’ll find all those neat and crazy
special effects, from bouncing buttons to team-created Web sites. Part [V
introduces all the GoLive action objects, in Dynamic HTML and on plain old
pages that come alive with actions. The workgroup server is a whole other
application introduced in this part for working with teams at remote sites.
Keep your pages looking cutting-edge with the information in these chapters
and your team workings in synch. (You'll also keep yourself up way past
your bedtime.)

Part U: The Part of Tens

If you want a summary of the most important things to keep in mind in
designing Web pages with GoLive 6, this is the place to be. In three concise
chapters, you get my ten best design tips for Web pages and sites, the ten
best features of GoLive 6, and the ten worst and most common mistakes
found in Web pages.

Icons Used in This Book

While writing this book, I would come to a section and think “Hey, the reader
could use this tip. [ use it all the time.” Keep your eyes open for these helpful
hints that can save you time and effort.

When a quirky little step or feature that’s easy to overlook crops up, I put in
a reminder. (These reminders were usually a result of my forgetting to do
something and figured that you could use the same reminder.)

5
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The technical stuff comes under the category Just Thought You Might Want
to Know Why. Most of the technical stuff | mention in Adobe GoLive 6 For
Dummies concerns code peculiarities, the different browsers, and something
about the Web or the Internet. If you come across a technical note, you can
take it or leave it. Whatever you do, though, don’t get all tangled up in it or
worried about the technical stuff. You really don’t have to know this stuff to
use GoLive 6. But if you're the kind who’s got to know the details, some of the
technical stuff might help you understand why certain features of your Web
page or site work they way they do.

Warnings are just what they claim to be: They warn you that if you do certain
things, you may run into unwanted consequences. For example, Internet
Explorer uses marquees and Netscape Navigator does not. So you're warned
of what to expect if one browser or the other views your page.

Where to Go from Here

Crank up your computer, open up Adobe GolLive 6 For Dummies, and start
having some fun with your Web pages. Get your bookmarks, yellow marker,
and all the stuff you want to make this book work for you. There’s no time
like the present to put together the finest Web site the world will ever see!
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In this part . . .

Get ready to jump into the turbocharged, silicon-
guzzling, big, bad mother of all Web-site-building

tools — GoLive 6. In no time at all, you’ll be leaving those
Web page tinkerers in the dust as you charge ahead with
untold power and tools to crank out red-hot sites and siz-
zling Web pages. With more tips on design than your
mother gave you on your first date, you’ll quickly tap into
the secrets of creating good-looking pages on budget and
on time. You’'ll even understand enough HTML to drop the
jaws of the pocket-protector crowd. What are you waiting
for? Get going with GoLive 6!

This first part of this book shows you how GoLive 6 uses a
system of toolbars, palettes, inspectors, menus, and win-
dows to help you put together great sites with ease. As
soon as you're familiar with the individual elements of
GolLive 6, you're off and running to create your own pages
and sites. Along the way, I'll let you in on the secrets of
good Web site design (my own, personal bag of tricks for
making your sites stand out as clear and good-looking
while avoiding the most common pitfalls that come from
ignoring design precepts). I'll also show you how to use
the GoLive 6 visual navigation tools and palettes to ensure
that visitors to your site find what you want them to find.
To end things with a bang, Part [ concludes with a quick
and clear tour of HTML that emphasizes how to use and
edit HTML tags with the GoLive Source and Outline views.




Chapter 1
Going Places with GoLive 6

In This Chapter
Web publishing by using GoLive 6
Recognizing the GoLive 6 main windows and tools
Using different views in the document window
Using menus to supplement on-screen tools
Working with context-sensitive toolbars and windows
Thinking the way GoLive 6 thinks
Using palettes and the Inspector

Pointing-and-shooting your way to a better Web site

ou've seen the Web, and now you want to become a part of it. No tool’s

better for getting you there, looking smart and looking good, than the
powerful GoLive 6 program. GoLive 6 enables you to express yourself, sell
your products, or get across your point with far more pizzazz than does the
standard, plain-vanilla, static text and graphics you often see on the Web,
set up as they usually are in a rigid, default HTML arrangement of spots and
spaces. GoLive 6 makes your pages stand out and get the kind of attention
you seek from Web surfers all around the globe.

You probably know what a Web page looks like on your own computer and
in your favorite browser, but GoLive helps you make your Web pages look
exactly the way you want on all different kinds of computers, monitors, and
versions of browsers. GoLive 6 helps you develop not only a Web page but
also entire Web sites of different pages that all link together, making the
entire site look easy and, well, just plain cool to use.

GoLive 6 is smart enough to write your code, place your pictures, and

even show you how your site looks on someone else’s favorite monitor

and computer (so that Windows users can see how it looks on a Mac and
vice versa) and in any browser — whether a visitor is using Netscape
Communicator or Microsoft Internet Explorer. GoLive 6 is smart, experienced
(hey — this version is the fifth time out for GoLive, after all), and intuitively
easy to use. It helps you avoid common mistakes in creating Web sites and
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has power to spare for even the most elaborate Web-slinging tasks. So
whether you’re making pages for the folks back in Toledo or way off in
Timbuktu, GoLive 6 gets you going on the World Wide Web fast — and
with plenty of class!

What's Up, Document Window?

To start using GoLive 6, just double-click the GoLive 6 icon on your desktop to
launch the application or in Windows choose Startr>Applicationst>Adober>
GolLive 6. After you launch GoLive 6, the big, gray rectangle you first see
on-screen is the document window. (Think of a document window as a canvas
on which you paint your creation.) Here’s where you bring together the
graphics, text, movies, links, and all the other parts of your Web page. After
you're inside a document window, you can use any of six different views to
create (as well as keep tabs on) your ever-evolving Web site. (For the curious
out there, the official names of these views are Layout, Frame Layout, Source,
Outline, Preview, and Frame Preview.) Each view has its own tab sitting along
the top of the document window, and you can easily toggle back and forth
between views by simply selecting the appropriate tab. You get a chance to
see what each view can do for you in the following sections of this chapter.

Layout view: Intuitive creations

You end up spending most of your time in Layout view while creating your
Web pages. That’s because Layout view is the place to go to drag graphics
into position, write text, and add on all manner of goodies you simply must
have on your Web page. Figure 1-1 shows the blank slate on which you create
your masterpiece.

After you first fire up GoLive 6, the program provides a dialog box with

three menu selections: New Page, New Site, and Open. Select New Page and
you see a page similar to the one shown in Figure 1-1, unless you change your
Preferences options to start out in some other view. (As you first start using
GoLive 6, however, you're probably best off leaving the preferences in their
default configurations.) Although the little icons along the top of the
document window in Layout view have important functions, you don’t need
most of them to get going. Keep the majority of them on your mental back
burner for now. You get the opportunity to become better acquainted with
those features elsewhere.

One tiny box you see in Layout view, however, may prove useful now. The box
in the lower-right corner displays the size value of the window in monitors of
different sizes. “Big deal,” you may say, and in most cases you're probably
right to remain unimpressed. But if you've invested in one of those big-screen
monitors and create your Web site with such a big monitor in mind, you may
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end up frustrating lots of folks: Those visitors with less-endowed monitors
may experience difficulty viewing the length and breadth of your Web site on
their tiny screens. You can plan for this situation, however, by creating your
Web pages for a monitor size that those viewing your Web site are most

likely to use. To change the monitor size settings, click the arrow next to the
number appearing in the box to open the window-size pop-up menu, as shown
in Figure 1-2. Then select the setting for the monitor size you want. A setting
of 580, for example, is appropriate for a 14-inch monitor, which is the most
common monitor size. For viewing on a 17-inch monitor, the menu shows

you that 780 is the right choice.

eoe 8 untitled.htm|
|[Gyour CINE " source BN IE ®)
B[S webnme to Adobe ol é @ B
|
[ % |shtmi> <body> > A 530 w2

£80 (14" Monitor)
780 (17" Monitor)

Tracing Image

Settings.

A new feature in GoLive 6 is Source Split view. In this view, you can see part of
your page and part of the HTML, Cascading Style Sheets (CSS — see
Chapter10), and the rest of the code that makes up your page — called the

11
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source code. Figure 1-3 shows the split view displaying Layout view on the top
and the source code on the bottom. You can use Source Split view with
Layout view, Frame Layout view, Outline view, and Preview view.
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The other views

After you familiarize yourself with Layout view, you can take a quick look at
the other views available to you from the document window. The following
list summarizes the basics of each of these other views (which I discuss in

greater detail in later chapters):

v Frame Layout view: Use Frame Layout view if you want to view and
organize all icons of the pages in a frameset at the same time. (A frameset
shows several Web pages on the same screen organized into sections
known as frames.) Unlike in Layout view, you don’t use Frame Layout
view for editing pages — it merely shows you which pages are in a
certain frameset. (Chapter 9 tells you all about frames.)

v Source view: Use Source view if you want to see and edit the source
code for the items you add to a Web page. This view is very useful if you
need to do a little code tweaking — you don’t need to open a separate
editor just to add a little HTML or JavaScript of your own. (Chapter 6
shows you how to use Source view to fine-tune your HTML.)

v Outline view: Outline view is similar in appearance to Source view except
that it includes a structural view of your source code — that is, you can
see the hierarchy of the blocks of HTML and JavaScript code. If you view a
Web page in Outline view, you can easily insert the cool styles you create
(and just as easily insert text) right into the code windows in Outline view.
(Chapter 6 explains how to use this unique GoLive 6 feature.)
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v Preview view: Use Preview view to take a peek at your page in a simulated
browser. Get to know this feature because you will use it frequently.

v Frame Preview view: Use Frame Preview view to preview any of your
Web pages in a frameset. You see all the pages in the frameset as they
appear in the browser. (Note: Only the Macintosh has Frame Preview
view. Windows computers view both frame and nonframe pages in
Preview view.)

To save some of your computer’s memory, just use Preview view rather
than keep a browser open to check how your page looks. Often, you need to
keep several applications open as you develop a Web page — for example,
a graphics program or a word processor — and these programs all take up
memory. As a bonus, you can simulate in Preview view just how your page
appears in different browsers on different computers, so you're not stuck
knowing how it looks just in your own browser.

Le Menu du Jour

|
Figure 1-4:
The Golive
6 main
menu bar,
across the
top of the
screen, can
be used in
conjunction
with the
many
Golive
palettes.
|

What’s up with all those menus? As you do in just about every other
application in Windows or on the Mac, you see plenty of menus in GoLive 6
(see Figure 1-4). Most of the work you do in the program, however, involves
its various inspectors, toolbars, controllers, and palettes. The menus contain
many features that are also on the support windows, bars, and palettes, and
until you're comfortable using the other GoLive 6 support elements, the
menus serve as a handy source for tools. As you use the support windows
and bars more and more, however, you become less dependent on the
menus — and accomplish your work much faster to boot.

[ @ Adobe GolLive 6.0 File Edit Type Special Site Diagram Movie View Window Help }
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You also find many of the less-often-used features, gadgets, and goodies on
the menus, where they don’t get in the way of your work area. The Special
menu, for example, contains a Select Upper Block option that’s used to select
the upper block of a page when using Source Split view. Usually, you just click
the upper block to select it; but, just in case, you can select it from the
Special menu — thankfully out of the way whenever you don’t need it.

As soon as you can, you want to break the menu habit. In GoLive 6, you quickly
find that using the windows, toolbars, and palettes that the program provides
is much quicker than using menus. But if old habits die hard, you don’t need to
tangle yourself all up by not using the menus either — at least to get started.

The GoLive Objects Palette —
at Vour Fingertips

|
Figure 1-5:
The Golive
6 Objects
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window full
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|

You can access several different windows from the Window menu on the
GoLive 6 menu bar. The Objects palette window (or just Objects palette), with
its 11 different tabs, is one of the more useful of these windows because it’s like
a toolkit from which you can choose various tools to use in creating your Web
page. Each tab offers several icons you can use in creating the Web page, and
you can drag each icon from the Objects palette to Layout view, which makes
the task of getting exactly the tool you need for your page quite easy indeed.

I suggest that you use the Basic tab of the Objects palette to start off, as shown
in Figure 1-5. (To give yourself some extra room, drag the corner of a palette to
stretch it out and place it at the bottom of your screen to free up space.)

Frames —— —— Dynamic Content
Head —Site
Forms — ——Site Extras
Diagram
Smart — WMLElements
Basic — QuickTime
— Library
[fonj c1s | oo (O]
HoEEH:d® % ¢ d s
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The general model for creating a Web page in GoLive 6 is simply to drag
materials (or icons) from the Objects palette over to Layout view, just as

you drag stones across a field to use in building that neighborly stone fence.
The Objects palette thus provides you with a handy, intuitive tool for building
your Web pages. The following list describes all the tabs of the Objects
palette, from left to right, and tells you what you can do on each tab:

v~ Basic: Use this tab to add general icons you use on several different kinds
of Web pages. The Basic tab includes familiar objects, such as tables and
horizontal lines. These Basic objects also include placeholders for SWF
(Shockwave) files, a grid, and floating boxes, among other objects.
(Shockwave runs animated movies made with Macromedia Flash and
Adobe LiveMotion.)

v Smart: The Smart tab contains a number of different kinds of objects
that easily perform some of the more complex Web-design tasks. You
can drag and drop a Rollover object, for example, to instantly set up a
Rollover button. Other smart objects include Photoshop and Illustrator
objects you can link and update in Adobe applications by the same
name. (Chapter 14 shows how to use smart objects. )

+ Forms: Forms in Web pages include different kinds of objects you use to
get information from your visitors. Use this tab to access several different
Web forms, such as text areas, buttons, check boxes, and menus you can
add to your pages to enable users to respond to information on the page.
(Chapter 8 tells you all about using forms on your Web page.)

v Head: Use the Head tab for creating special code (such as JavaScript
functions) that goes in the Head section of an HTML page. (The Head
section loads before the body of your page and can store important
functions and information about your page.) You can put in the Head
section some information about your site that helps search engines find
your Web pages by using meta tags, and GoLive 6 provides a handy Meta
icon for you to drag and drop in the page’s head. Chapter 6 explains
how. Also, your title goes in the head.

v Frames: You use the Frames tag for creating framesets. The process is
very simple on this tab: Just drag and drop the frame arrangement you
want from the tab to your Web page. (Chapter 9 acquaints you with this
innovative and simple process for creating framesets.)

+* Dynamic Content: This tab is new to the Objects palette in GoLive 6.
When you're ready to link up your pages with “back end” middleware
like ASP and PHP, and to databases, this tab is where you should start.

v~ Site: The Site tab enables you to add icons you use in the site window.
(The site window enables you to see all the other Web pages, graphics
files, and other media files that make up your Web site.) You can drag
and drop font sets or color schemes from this tab for use throughout
your entire site. You can also drag blank pages from this tab to add to
the site. (Chapter 11 covers all the details for this tab.)
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v~ Site Extras: Use this tab to retrieve your own site extras that you create
in the site window. You can create and drag templates and components
from this tab to your Web page. (Components are reusable page elements
that do something for a Web page, such as an image map you want to use
for navigation on different pages in your site.) After you create a cool
design and devise components for it once, you can use the same design
and components over and over again by simply dragging them from this
page. What’s more, when the original is changed, all the components in
the site are automatically updated. (Chapter 12 shows how to create
templates and components and then use them in your Web pages.)

v Diagram: This tab represents another new feature in GoLive 6. When
working with diagrams to plan your site, you can now add to each page
all the elements of the most simple or advanced site as you plan. For
example, you can add a PHP element and then a database element that
links to the PHP element. Your whole site, including the back end, now
becomes clearly laid out before your eyes.

v WML Elements: For setting up pages for Wireless Markup Language, this
new GoLive 6 feature allows you to add WML elements to any page you
want. You just drag and drop the elements to the page you want. (Talk to
your PDA!)

v QuickTime: Lights! Camera! Action! You can use this tab to direct your
own movies in QuickTime, the video-compression software that enables
you to create and view movies on the Web by using either a Windows
or Mac computer. GoLive 6 enables you to edit QuickTime movies with
some great special effects. (Chapter 15 shows how to put your movies
in the biggest theater around — the World Wide Web.)

v Library: You can create an object on one Web page, drag the object to
the Library tab, and then use it on another Web page. That process
saves you from needing to reinvent the wheel every time you create a
page. (Chapter 12 tells you about creating objects for the library.)

A Rainbow at Your Fingertips

You may notice that the Color palette lives in the same window as the
Objects palette. The GoLive 6 Color palette features nine different tabs; each
represents a different way to look at colors and describes the number of
colors available to you for different projects, including ones you make
yourself. Tab 7 (the seventh from the left) contains Web-safe colors, or colors
that appear the same on all monitors displaying 8-bit colors — a full 216 of
them. At one time, using Web-safe colors was important because so many
monitors had 8-bit color processing; however, that is no longer the case, and
designers no longer feel constrained by the paltry palette of the Web-safe
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color limits. Drag colors from the Color palette’s preview pane to an object
or an object’s color well. Or, you can just click the many different context-
sensitive color wells that appear when you select an object that can be
colored. The Color palette jumps to the screen and, by selecting the color on
the palette as soon as the color well fills with the desired color, the object
gets colored too. Figure 1-6 shows the Web-safe (Web Color List) tab in the
Color palette.

Gray Slider —————— HSB Wheel
RGB Slider HSV Picker
CMYK Palettes
Slider )
— Web Color List
Web Name List
— Site Color List
Figure 1-6: _ —
YOIJ use [U Objects [ folo [C]
theColor (BB QO @ @(6e O
palette to value [FFFFCC
easily S
change the rirss
colors of #FFFEOD
backgrounds e
and fonts on HFFCCTD v
your Web w7
page.
|
P Your GoLive desktop can become crowded with all the windows you open

on-screen to help create Web sites and pages. By pressing Control+Tab

(on the Macintosh) and Ctrl+Tab (in Windows), you can make all the palettes
and toolbars disappear while you concentrate on your Web pages and site.
Another press of Control+Tab or Ctrl+Tab toggles these items back to the
desktop.

The Many Faces of the Toolbar

The GoLive 6 toolbar is context sensitive, meaning that the toolbar changes
with what you’re working on. (The toolbar is very smart and knows exactly
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what you’re doing at any given moment.) The toolbar serves as a handy bar
of buttons that enable you to access specific GoLive 6 features quickly.
Figures 1-7, 1-8, and 1-9 in this section show three of the different GoLive 6
toolbars, all of which I describe in the following sections.

The Text toolbar

If you're placing text on your Layout page, you see the Text toolbar (see
Figure 1-7). This toolbar provides quick access to several text-formatting
tools and to the Link and Remove Link buttons. Believe me, using the Text
toolbar is much faster than fishing through menus to find the formatting
options you need.

Numbered Increase Link
List  List Level Warning
Align Align
Left Right Italic Size

Show in Browser

New Link

e[ METET=IEILIT] = Bl EEk: 4| ESGOIE IE-N - ]
Paragraph Bold Text Color Decrease Select
Format List Level Window
! Teletype
Align
Center Unnumbered List Remove Link  Adobe Online

The Objects toolbar

In working with objects on the GoLive grid, such as graphics and text-layout
boxes, you use the Objects toolbar (see Figure 1-8). In Chapter 3, you find out
all about the grid and how it makes placing objects on the page as simple as
pie — and that includes adding text-layout boxes so that you can place text
anywhere you want on-screen. After you select an object, you can quickly
type information about object sizes and positions in the toolbar’s text boxes
or click buttons on the toolbar to designate what you want the object to do
without needing to fish through menus to obtain the same results. Just click
the appropriate buttons on the Objects toolbar, for example, for the quick
alignment of selected objects.
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One browser at a time on your toolbar

The sharp-eyed among you may notice that
some Golive 6 toolbars feature a different button
at the far right. In GoLive 6, you can select how
many — and which — browsers launch after
you click this last button. Unless you have lots
and lots of memory, however (DRAM memory,
that is — the kind your computer has only
after you turn it on), launching more than one
browser at a time is expensive in terms of
memory use and may even result in lockups. If
you have enough memory, however, and rou-
tinely examining your pages in multiple browsers
is critical to you, you're likely to find this feature
very handy. To make changes, just choose
Edit->Preferences from the menu bar and

click the Browsers icon in the left pane of
the Preferences window that appears. In the
Browser Selection window that appears on
the right, select which browser you want to use
as your primary one. (GolLive automatically
searches your computer for browsers and then
brings them into the Browser Selection window.)
The checked browser's icon appears on the tool-
bar as a button. If you don't want either as the
primary browser, remove the check mark from
both browsers; a Globe button then appears with
a drop-down list menu that enables you to select
either one. (If you select both in the Preferences
window, you also see the Globe button rather
than either browser button.)

The Site toolbar

19

In thinking about GoLive 6, the first thing you must do is to get beyond thinking
only about individual Web pages; the beauty of GoLive 6 is that it makes tying
all your Web pages together into a true Web site extremely easy. And one of the
tools that GoLive provides to help you do so is the Site toolbar.

|
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After you select the site window, the Site toolbar appears on-screen

(see Figure 1-9). This toolbar provides you with easy access to the different
options available in the site window and its accompanying windows and
tools. Select a file in the site window and click, for example, the Page button
to open it, the Trash button to delete it, or one of the other buttons on the
bar to obtain information easily. The third button from the right, for example,
toggles between the site window and your document window, enabling you
to switch easily between Layout view of a page and one providing specific
information about that page within the overall Web site — such as where it
lies relative to all the other pages in the site. Click the second-to-last button
on the right, and you can view any file in the site window within the browser
of your choice. On the Preferences menu, you can set up your default
browser to make it easier to access.
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Delete Change All ~ Incremental Download
Selected Item References
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New Refresh Web DAV

Folder View Controls Link Warning
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Open Find FTP Connect Toggle Site Settings
Files
inSite  ~——— Open in Out Links Palette

Show Information in Finder (Mac only)

The Outline toolbar

As you’re working in Outline view, you discover that the available toolbar
buttons become pretty sparse as well — but still, the Outline toolbar has just
what you need (see Figure 1-10). A single click of a button on this toolbar
enables you to insert special code for Active Server Pages and XML, add
comments to your HTML code (so that you can remember later what you
want it to do), and insert text. (Chapter 6 tells all about using Outline view
and its toolbar as well as HTML tags.)
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The Navigation and Diagram toolbars

In creating a site design, you're creating an organization and navigation
system for your site. The organization of a site is how the pages are to be
grouped and ordered, and the navigation considerations refer to how the
groups are to be linked. Before you start making a set of Web pages, you
need to get an idea of how your Web site will look. Imagine that you have
little cutout cardboard squares for each page that you can lay on top of a
table and organize with pieces of yarn indicating links. In the Diagram and
Navigation windows, that’s exactly what you do — set up a design diagram-
and-navigation system to see the relationship between all your pages.
Naturally, the toolbars for these windows look similar, although with some
key differences (three buttons on the Diagram toolbar let you check the
design for bugs and add or remove elements of the design to or from the
site window), as you can see in Figure 1-11 (Navigation) and Figure 1-12
(Diagram). (Chapter 11 covers using the site diagram tools.)

New Next Page ~ New Previous Page

Refresh View Unfold All
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Reveal in Site Toggle Orientation
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Keeping Everything in Site

Even if you plan to create only a single-page Web site, the site window in
GolLive 6 is likely to quickly become one of your favorites. You can quickly
create a site by selecting FilecoNew Site from the menu bar, creating a blank
site in the Site Wizard, and saving the site in a folder on your computer. You
are given a new page named index.html with the site. From the Files tab in the
site window, you can open that page into a document window by double-
clicking the file icon. The site window shows everything you need for your
site on six different tabs (or views, a term I use interchangeably), and it
makes creating sites very easy. You can drag your files from anywhere on
your computer onto the Files tab of the site window, for example, and a copy
of that file goes into the root folder for the site. The Files tab shows the root
folder for your site, including folders within the root folder. Figure 1-13 shows
the Files tab of the site window for a typical Web site you can create in
GoLive 6. All the different media appear together in a single Media folder, and
you can easily see each page of the site within the window.

You can move back and forth between the Site and document windows by
clicking the third button from the right on the toolbar. If you're in the site
window, the button for the document window appears on the toolbar, and if
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you're in the document window, the site window button appears. Play around
with switching back and forth to accustom yourself to this simple switch. You
will switch back and forth frequently before you’re through creating your site.

Switching between the site window and the document window makes
organizing your site much easier because you can see where everything is
and obtain a better overall sense of where your work lies in the context of the
site. So, as you're working on a page, you're likely to be looking at not only all

the pages and media you need for the current page, but also those for the

entire site.
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Files view

The first tab in the site window opens a window displaying all the files in
your site — Files view (refer to Figure 1-13). This handy overview enables you
to know whether all your files are in place and whether they’re working right.
Different symbols in the Status column show you either that something is
wrong with a file (in which case you see a big, green bug) or that your files
are up-to-date (a check mark designating this status appears). You use the
right frame of the window for adding components, templates, designs, smart
objects, and stationeries — either those you store from previous sites or new
ones you develop for use in future sites. (Stationeries are pages you use as
templates, and components are reusable page elements — I explain both in
detail in Chapter 14.) You can also toss an unwanted file into the Site Trash
folder in the right frame.

External view

Open up External view by selecting the External tab in the site window. Ever
see a link to a Web page or an e-mail you want to put on one of your Web
pages? All you need do is to drag a URL (a link to an external Web address)
from a browser page to External view of the site window, and GoLive 6 stores
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that link there. Then you can select text or an image and easily link it to that
URL or e-mail address. The Site window’s External view makes life easy
because you can use your browser to surf throughout the World Wide Web,
drag all kinds of links and e-mail addresses into your Site window, and then
use those links and addresses whenever you need them. (Chapter 11 explains
how to use External view and bring in all the e-mail and Web site addresses
you want.)

Diagrams view

The Diagrams tab gives you access to Diagrams view, a new feature in GoLive 6.
In Diagrams view of the site window, all you see is a list of diagrams (see

Figure 1-14), but from this view you can launch your own site design windows.
Think of Diagrams view as a place where you can try on all different types of
diagrams and then store them. Then, after you decide that you're ready to
make a design choice, you go into this view and select the one that best fits the
needs of your site. Diagrams can be stored, and when submitted they become
part of your Site window. You can try out several diagrams and then submit
the one you like best. Part of the design-preview process includes inserting
potential links between pages for a navigation overview. (Chapters 4 and 11
show how GoLive 6 handles both site design and navigation planning.)
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Colors view

A good Web site displays a set of colors that go well together. You can easily
keep such a set of colors consistent by dragging all the colors you use on
your site from the Color palette to Colors view of the Site window. (Access
Colors view by selecting the middle tab on the left side of the Site window,

as shown in Figure 1-15.) After you move a specific set of colors to the Site
window’s Colors view, the Color palette places those same colors together as
a set on the Color palette’s own Site tab (the tab farthest to the right). You
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can then access just the set of colors you need from either Colors view of the
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Site window or the Site tab of the Color palette. (Chapters 7 and 11 tell you

lots more about colors and using colors in the Site window.)
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Font Sets view

Font Sets view, accessed by selecting the second tab from the right in the
Site window, helps you set up the fonts (type styles) for your Web site
(see Figure 1-16). GoLive 6 provides several different ways to put font sets

on the Font Sets tab. Give the font set a name, and you can then drag it from
there to text on any page in the site you want. (This process also is easier than
wading through the menus to perform the same task.) As with everything else
in GoLive 6, the Site window’s Font Sets view makes the job of creating a great
Web site that much easier. (Chapter 11 provides more details on how to get
your font set and site together and the different ways to go about it.)
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Library view

The final tab on the Site window is Library view (see Figure 1-17). Whenever
you develop anything on a page that is so cool that you want it on several
pages in the site, just drag it to Library view. You can drag everything from text
to loaded Shockwave files to Library view. When you need any of the objects
stashed on the Library tab on one of the other pages in your site, just drag the
object from Library view to your page. (I like to think of Library view as my
attic, where all sorts of odds and ends can be stored until I need them — even
if  never use them.)
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Inspector GoLive, at Vour Service

As you work on different parts of your Web page or Web site, the GoLive 6
context-sensitive Inspector is always at your side. You soon discover that the
Inspector is a bit of a chameleon, however, changing disguises as Inspector
Clousseau does, as the need arises. Happily, the Inspector’s changeable
nature saves you from spending lots of time fumbling through menus looking
for what you need, because it always pulls the context-appropriate rabbit out
of its hat just at the time you need it the most.

You can summon the Inspector to your side (on-screen, of course) by
choosing Window=>Inspector from the GoLive 6 menu bar. Depending on
what you're doing at the time you access the Inspector, different Inspectors
arrive on-screen. If you’re working with text, a Text Inspector arrives, but if
you're selecting an image, the Inspector takes on the guise of Image Inspector
(see Figure 1-18). Using the Inspector really isn’t all that complex; just
remember that it changes its persona on-screen, depending on what you'’re
doing with your Web page or site at any given time. After you entice the
Inspector on-screen, you don’t need to call for a different Inspector if you
decide to start working with some other component of your site. The
versatile Inspector changes its identity automatically as you change tasks.
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Watch the toolbar as the Inspector changes. Often, the toolbar changes at the

same time, depending on what you’re doing.

The View palette is the Inspector’s roommate — they live in the same
window. The View palette is handy for setting the appearance of your Web
page in Layout view (see Figure 1-19). You can control how the page will look
before you examine it in Preview view or in a browser. You can establish the
type of browser and the type of computer on which you want to view your
pages as you're working on them. You can set all links to appear as they do
after someone visits them, for example, rather than how they look before a
user clicks them. Suppose that you're working on your Mac, but you want to
check to see how the page will look on a Windows computer using Internet
Explorer 5. Just set your View palette, and your page appears as it will look in
Windows using Internet Explorer 5, as illustrated in Figure 1-19.

Context what?

| bandy about the term context-sensitive
throughout this chapter, so providing a little clar-
ification here may help you to understand just
what | mean by it. Something that's context-sen-
sitive is like a really smart carpenter’s assistant:
If you're nailing a board, the assistant knows to
hand you a hammer and nails; if you need to cut
some wood, however, your assistant hands you
a saw. The Inspector | describe in the accom-
panying section is similar to such a smart assis-
tant in that it gives you exactly what you need
when you need it. Having such a capability

makes a great deal of sense if you're working on
different parts of a Web page or site. If, for
example, you select text that you indicate you
want to use as a link (which you do by clicking
the Link button on the toolbar), the Text
Inspector’s Link tab provides all the tools you
need for finding the page to which you want to
link. If you're working on a graphic, however, you
need to inspect different things, so the Image
Inspector provides a different set of windows
and buttons you need for that purpose.

27



28

Part I: Ready, Set, GoLive 6!

|
Figure 1-19:
The View
palette
provides
many
options for
changing
the
appearance
of objects.
|

o0
| Inspector {1 Wiew
Profile [ Bxplorer § Win Windoms)
W allow owerlapping paragraphs
isibility | Shew all itern 3 =
™ mages [ Low Source
Background
Fonts &l =
Links Nomal (%]

Layaut

The Rest of the Cast

The windows you use the most are the document window, the Site window,
the Objects and Color palettes, and the Inspector. After you set up the View
palette, you use it only occasionally. Several more windows and their palettes,
however, are available for specialized tasks that | can best explain as you
explore in subsequent chapters the tasks they perform. Not giving them at
least some introduction here would, however, be impolite, so the following list
offers a brief introduction for the rest of the windows and palettes you find in
GoLive 6. (GoLive 6 groups its palettes by the windows in which they live.)
The palettes are all found on the Window menu bar and in this section are
grouped by the palette window in which they reside. Most of the following
palettes also have a counterpart in the Inspector, who dons the appropriate
face to work with the palette and object you select. (The following groupings
have no intuitive or inherent combinations. They are simply grouped that way
in palette pack windows. Each palette has its own tab, but they are always
referenced as palettes in GoLive 6.)

The Transform, Align, and
Tracing Image palettes

The Transform palette helps change an object’s configuration, most notably
its size.

You use the Align palette to arrange objects in your Document or Design
windows.

You can use the Tracing Image palette to trace images from Photoshop in the
predesign stages of your Web-page layout. You can see what the layout looks
like on your page with other elements before you settle on using it.
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The Floating Boxes, Table,
and Actions palettes

You can use the Floating Boxes palette to control floating boxes in GoLive 6
on your Web page. Floating boxes can move around a page when you apply
an action to them. (See Actions below and Chapter 16.)

You can set your tables and style them easily by using the new GoLive 6
features on its Table palette (see Chapter 5).

The Actions palette enables you to generate JavaScript to make your objects
come alive. (These are the kinds of actions that make floating boxes fly
around the page.) Just add the action you want, and GoLive 6 does the rest
(see Chapter 14).

The In & Out Links, Site Navigator,
Source Code, and JavaScript Shell palettes

The In & Out Links palette shows you the links for selected objects on your
page (see Chapter 4).

The Site Navigator palette provides a thumbnail view of the Navigation Links
or Design window icons and controls the size of the page icons in both the
Navigation Links and Design windows. (Powerful little guy!) (See Chapter 4
for the details.)

Whenever you make a change in Layout view, the source code (HTML,
JavaScript) appears in the Source Code palette. You make fine adjustments in
one and view the changes in the other (see Chapter 6).

In the JavaScript shell, you Enter JavaScript commands and then test-drive
them.

The Highlights palette

When you want to check your pages and highlight any elements or potential
problems, use the Highlights palette. With this palette, you can check links,
warnings, elements, CSS, JavaScript actions, items with URLs, text items,
comments, and special items. Each feature appears in a highlight color, so it’s
easy to separate different elements in your page. This new feature in GoLive 6
is a nice debugging tool.
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The Dynamic Bindings palette

The Dynamic Bindings palette is used for connections between middleware,
like PHP and ASP and databases.

The Pending Links palette

In Site view, the Pending Links palette is handy for looking at the different
links on the pages in the site. Just click on the page in Site view, and all the
links appear in the Pending Links palette.

The Template Regions palette

When you’re setting up or using a template, its different regions can be
identified as objects with the new GoLive 6 Template Regions template. You
can rename the region objects so that you can quickly individualize regions
on a page.

The CSS palette

Another new GoLive 6 palette, the CSS palette, appears on the page to let
you select text and apply different classes, IDs. or tags. After you start using
CSS, you will want this palette handy while you’re creating a dynamite site.
Chapter 10 discusses using CSS, where you find out more about the CSS
palette and his close cousins the CSS Definition and CSS Source palettes.

The HTML Styles palette

You will find that styles are easy to create, import, edit, copy, export, delete,
and apply using the new HTML Styles palette, introduced in GoLive 6. The
palette can be filled with the styles used in your site, and it makes it easy to
use any style you want as well as to create new ones. The palette even has
two palettes of its own — the New Styles palette and the Edit Styles palette,
for creating and changing styles of your own.

The History palette

The History palette is so cool that you will use it all the time. Each time you
do something in creating a page or site, GoLive 6 records that action in the
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History palette. If you make an error — or several, as [ do — you need a way
to undo the mess. Just select the point in the palette’s history list where
things were going right, and the History palette discreetly removes anything
that may have been added after that point.

Just Point and Shoot Me
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One of my favorite features of GoLive 6 is the Point-and-Shoot button — the
little spiral or squiggle icons you see in the context-sensitive Inspectors. By
dragging a pointer line from one of these buttons to a file, a graphic, or some
other object on the page, you can easily and intuitively create a link to or
place that object on a Web page. Figure 1-20 shows how an image icon from
the Objects palette links to a graphic in the Site window. (The buttons and
their pull-lines not only are intuitive to use, but also look pretty cool.)
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Throughout this book, you find Point-and-Shoot buttons in different places
besides the Inspector. If you use Point-and-Shoot buttons, all the links relate
to the root (site) folder. So whenever you see the little corkscrew button, you
can point, pull, and shoot your way through page design as long as you have
placed your pages and media in the root folder. (You know that they’re in the
root folder if they are listed in Files view in the Site window.)



